
Software License Agreement 
 
CD-Mediaworks grants you a non-exclusive license to use a copy of our program subject to 
the following terms and the proprietary notices, labels or marks on the program and the 
accompanying documentation. Any License Agreement included with the product takes 
precedent over this agreement.  
 
You may:  
1. Use the program only on any one computer at any one time.  
2. Make a copy of the program in machine-readable form for archival purposes as long as 
all proprietary notices are reproduced on each copy.  
 
You may not:  
1. Modify, translate, reverse engineer, decompile, disassemble, or create derivative works 
based upon this program.  
2. Rent, transfer or grant any rights in this program or accompanying documentation in any 
form to anyone else without the prior written consent of CD-Mediaworks.  
3. Remove any proprietary notices, labels or marks on the program and accompanying 
documentation.  
4. Use this program, or permit this program to be used on more than one computer at any 
one time.  
 
This license is not for sale and it may not be assigned or sublicensed to anyone else. Title 
and copyrights to the program and the accompanying documentation and any copies 
remain with CD-Mediaworks.  
 
If you do not comply with any of the above restrictions this license will terminate.  
 
LIMITED WARRANTY AND DISCLAIMER  
If, within 30 days from your first use of this product, you are not satisfied with it for any 
reason, you should stop using it and notify CD-Mediaworks. If you return to CD-Mediaworks 
any materials that CD-Mediaworks has sent to you in connection with the product CD-
Mediaworks will, at your option, either refund your purchase price or replace the product 
and related materials.  
 
CD-MEDIAWORKS LIABILITY IS LIMITED TO THE REPLACEMENT OF THE PRODUCT 
AND RELATED MATERIALS OR THE REFUND OF THE PURCHASE PRICE. THIS IS 
THE ENTIRE LIABILITY OF CD-MEDIAWORKS AND IS YOUR EXCLUSIVE REMEDY. 
CD-MEDIAWORKS SHALL NOT BE LIABLE FOR ANY OTHER DAMAGES OR LOSSES 
INCLUDING DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES OR LOSS OF PROFITS TO YOU OR ANY THIRD PARTY INCLUDING, 
WITHOUT LIMIT, LOSS OF DATA. 
 
The foregoing limited warranty is in lieu of all other warranties, express or implied, including 
but not limited to, the implied warranties of merchantability and fitness for a particular 
purpose. This agreement is the entire agreement. If any provision of this agreement is held 
invalid, the remainder of this agreement shall continue in full force and effect.  
 
IF YOU DO NOT AGREE TO THE ABOVE TERMS AND CONDITIONS AND CONTINUE 
TO USE THIS PRODUCT AND/OR DO NOT RETURN THE RELATED MATERIALS 
WHICH CD-MEDIAWORKS HAS SENT TO YOU. CD-MEDIAWORKS WILL HAVE NO 
OBLIGATION TO YOU WITH RESPECT TO THIS PRODUCT OR THE RELATED 
MATERIALS. THE USE OF THIS PRODUCT AND RELATED MATERIALS WILL BE AT 
YOUR SOLE RISK AND YOU WILL BE LIABLE TO CD-MEDIAWORKS FOR THE PRICE 
OF THE PRODUCT AND RELATED MATERIALS. 
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WELCOME TO HOLDON™ FOR WINDOWS 
 

 
 

MAIN SCREEN 
 
This is the main screen of the program. As you can see, the interface has been 
designed to emulate the "look and feel" of an office telephone. The diagram 
shown above illustrates that all of the main functions and features of this 
program are accessible from the main screen. 
 
For your convenience, all of these functions are also accessible through the 
familiar Windows drop-down menu system. There are also a few extra functions 
offered exclusively through the menus. 
 
This program is highly customizable --with many useful features.   
 
Read on for a brief overview and tutorial to help you get started using the 
program. 
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STARTING UP 
 
Make sure that the WAVE AUDIO and MIDI drivers for your computer's sound 
system are already installed into the Windows Operating System. (In other 
words, does your computer already make music and talk?) If not, you may need 
to install the support software for your soundcard (e.g., Creative Labs, Yamaha, 
Turtle Beach, etc.) into the "Windows Control Panel | Multimedia | Drivers" 
section before using this program.  See next page for details. 
 
THE FIRST TIME THAT YOU RUN THIS SOFTWARE the program will 
attempt to automatically detect and configure your computer's Sound and MIDI 
setup. The program will use your system's default Wave Output Device (i.e. 
from the Windows Control Panel | Multimedia |Audio Playback Output Device 
Settings) for outputting digital audio, and use the default MIDI Output device 
from your system's list of installed MIDI Output Devices (e.g., Windows 
Multimedia MIDI Settings.) 
 
Since there are normally a number of MIDI Output Devices installed in a typical 
Windows Multimedia System, you may wish to change the automatic MIDI 
Output Device setting. Simply choose the program's "File | MIDI Settings" 
menu item, and click on the MIDI DRIVERS TAB, shown here: 
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TUTORIAL: USING THE PROGRAM 
 
This tutorial assumes that you've already installed the program and that the 
soundcard output drivers are installed into the Windows Multimedia Panel . 
 
Hold-ON is very easy to use. To begin, you can simply press the START button 
located on the lower-right part of the "virtual telephone." This will cause the 
program to operate in it's default mode, which means that all SAMPLE message 
announcements and MIDI music will play (in all genres), and the program will 
randomly choose which music and messages to use.  
 
To get a quick idea of how the program works, press the START button now 
and give it a listen. When the program is active the START button transforms 
into a STOP button, and the word PLAYING is displayed on the bottom-left 
portion of the "virtual phone" (below the receiver). When you're ready to go on 
press the STOP button 
 
Now that you've heard how Hold-ON sounds, perhaps you'd like to customize 
the program by selecting specific music categories that you'd like to hear. For 
example, you may like to have your listeners hear only classical music, or jazz 
and pop, or any combination for the six music categories offered. When 
December rolls around, you may want to select the "custom" category, which 
puts your listeners into the appropriate celebratory mood. 
 
Select the music categories you would like to hear by mouse-clicking in the 
appropriate box as seen in the side panel illustration. Here, we have all the 
categories selected.  
 
To select individual songs for immediate playback, we can choose from the 
drop-down list of songs that is comprised of all the music categories that are 
check-box enabled from the previous step. This song-picker listbox (located at 
the bottom-middle of the screen) also displays the "currently playing" song. In 
this example, ethn03.mid is playing. 
 
If you would like the program to play only music selections, deselect (disable) 
the USE MESSAGES checkbox located in the top-left portion of the screen.  

 
 
You can also use the PLAY MUSIC button to put the program into music-only 
playback mode. 
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Press the START button to have the program play your selections.  
 
 

    
 

 
 

Music Categories Selector  
 

 
The "current song playing" and "song picker" listbox.  

 
 

 
 
Press START button again to effect changes and begin or resume playback. 
 

 
SELECTING MESSAGES 
 
Now that you've heard how great the music sounds, perhaps you'd like to 
customize the program even further by selecting specific message 
announcements that you'd like  to hear.  
 
For example, you may wish to have your listeners hear news or sales events 
specific to your business. Or, you may wish to simply use only a few of the 
great-sounding sample messages that you get with the program. 
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To "preview" a message (without putting the program into full-playback mode), 
simply click on any message located in the message playlist (shown below). 
 

 
 
To remove a message simply highlight the undesirable message and double-
click on the message name.  
 

To select individual message, first press the GET MSG button.   
 
Then you’ll see the familiar Explorer-type dialog (as shown here). 
 

 
 
 Files are automatically filtered to only show valid message filetypes (e.g., 
*.wav, wma, mp3).  
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You can choose valid message files from anywhere on your computer system: 
CD-ROM drive, Network Drive, Local Hardrive, etc.  
 

 
To add a message simply double-click on the name of the message file you wish 
to use with the program, or highlight the file and press the ADD button. 
 

 
To clear all messages and start your list over, press the CLEAR button. 
 
<Repeat this procedure as often as necessary in order to have a complete custom 
message playlist.> 
 

 
Press the DONE button when you are ready to return to the main screen. 
 
Press the START button to have the program play using your selections. 
 

    
 
 

 
 
NOTE: Make sure the USE MESSAGES checkbox is enabled so 
that message announcements will be used. 
 
 

 
 
 If you wish to make/use custom music files (e.g., MP3s, WMAs, 
etc.), follow the same procedure as above, starting with the GET 
MUSIC button. 
 



 9 

RECORDING MESSAGES 
 
In order to have your listeners hear news or sales events specific to your 
business, you must first record your message announcement. Note: there are 
many 3rd party recording studios that  are equipped to provide you with a 
computer wavefile, if desired.  
 
As mentioned, announcements can be made up of any wave (digital) audio files 
accessible to your computer. You can use professionally prerecorded messages 
or you can create and use your own.  
 
Note: you will require a microphone connected to the LINE-IN on your 
computer's soundcard in order to record your own messages.  
 
You can use any digital audio recording software you wish to record your 
message Multimedia Computer Systems or Sound Cards. 
 
You can also use the built-in Windows recorder by pressing the MICROPHONE 
button, as shown here: 
 

 
 
 
This button will launch the following recorder: 
 
 

 
 

Press the RECORD button (shown above) and speak into your microphone to 
record a new message. Press the STOP button when finished and choose FILE | 
SAVE AS... to save your recording with a unique name. (The default name is 
newmess.wav.)  
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When you are finished with the recorder, choose FILE | CLOSE to close the 
recorder program. 
 

 
 
To bring your freshly recorded message into the program,  press the GET MSG 
button and select the file you just recorded. See the previous steps for additional 
details on selecting message files. 
 
Press the START button to have the program play using your selections. 
 
Hold-ON automatically mixes your sound and messages so that they will sound 
good together. It does this by lowering the music volume during message 
playback –then raising it again when the announcement is finished.  
 

MIXING THE MUSIC AND ANNOUNCEMENTS 
 
The following controls are useful features for customizing this mixing operation: 
 

 
 
The FADE AMOUNT slider controls how much the Music will fade when a 
message is being played.  
 
The MUSIC slider controls the current volume of the Music playback channel. 
 
The VOICE slider controls the current volume of the Voice/Wave playback 
channel. 
 
THE 20%, 35%, and 50% buttons are preset FADE, MUSIC, and VOICE levels. 
 
Hold-ON relies on your computer's sound card for many operations. As such, it's 
important to ensure that you are familiar with the various settings required to 
operate your soundcard. Most of these settings are accessed though the 
Windows "winmixer". This control panel offers settings such as volumes, 
recording levels, etc., and is easily accessed through the program by pressing the 
F5 hotkey. 
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F5 Key Launches 

 
 
In this mixer panel, make sure that the PLAY CONTROL, WAVE channel, and 
the MIDI channel are not muted, and that the overall volumes are set to a 
moderately high level (e.g., 8 or 9.) 

USING AN EXTERNAL SOUND SOURCE FOR MUSIC 
 (e.g., CD-PLAYER ,SATELLITE, ETC.) 
 
You may wish to use your computer’s CD-ROM drive as an Audio input source. 
In this case, select the PLAY | USE CD-AUDIO/EXTERNAL MUSIC menu 
option. This will allow you to use the CD-PLAYER as an alternate music source 
for use with the program. 
 

 
 
Then select your SoundCard’s CD-AUDIO input channel from the drop-down 
listbox as seen here. 
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At this point you can simply pop in your favorite CD and press the PLAY 
button. The CD-Player will be automatically launched and started. 
 
Or, you can manually launch the Audio-CD Player, customize the player’s 
settings, and start the AUDIO-CD playback. 

 

  
 

Launches the default Windows CD-AUDIO player. 
 

  
 
Press the PLAY button (as shown above) to start the CD-AUDIO playback. If 
you have more than one CD-ROM drive you may need to specify the drive letter 
of the CD-ROM that contains the AUDIO-CD (i.e. Drive ‘F’ in the illustration 
above).  
 
If you need additional instructions on running the Windows CD-PLAYER select 
the HELP Menu from within the program. 
 
We hope that this brief overview helps to get you up and running with Hold-ON 
quickly and easily.  
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Menus and Commands 
 
FILE MENU 
 

 
 
The File Menu offers five file-handling commands: 
  
Save All Preferences saves all of the program’s current settings so that the next 
time you run the program it will restore your current configurations/settings. 
 
Load Default Message List loads the file MESSLIST.TXT, which holds the list 
of filenames corresponding to your message announcements. These filenames 
also appear in turquoise the Message Playlist area of the main screen. 
 
Save Message List saves the current names that appear in the turquoise 
Message Playlist area of the main screen to a file called MESSLIST.TXT. This 
file corresponding to your message announcements and can be reloaded by the 
preceding Load Message List command.  
 
Load Default Music List loads the file USERLIST.TXT, which holds the list of 
filenames corresponding to your message announcements. These names also 
appear in turquoise the Message Playlist area of the main screen. 
 
Save Current Music List saves the current names that appear in the turquoise 
Music Playlist area of the main screen to a file called USERLIST.TXT. This 
file corresponding to your message announcements and can be reloaded by the 
preceding Load Default Music List command.  
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EDIT MENU 
 

 
 
The Edit Menu offers the following features: 
 
The MIDI Control Panel Settings command launches the Windows 
Multimedia Properties panel, which allows you to select from all the different 
MIDI sound sources offered by your computer. 
 
The Windows MixerVolume Control launches your soundcard’s Windows 
Mixer program, where you can make global adjustments to your computers 
sound system. 

 
The Current Default Message List command launches the Windows Notepad 
program and automatically loads the current MESSLIST.TXT file, which allows 
you to make edits to the message playlist. 
 
The Song (category) Lists command launches the Windows Notepad program 
and automatically loads a given playlist file (as selected by choosing from the 
categories listed in the Song List Sub-menu), which allows you to make edits to 
the song playlist for that music category. 
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PLAY MENU 
 

 
 
The Play Menu duplicates the various play buttons located in the lower-right 
area of the main screen: 
 
The Play All command plays music only (no messages). Music is selected from 
all music categories and their associated lists. 
 
The Play Selected feature plays only the music that is selected (checkbox 
enabled) in the Song Category region of the main screen (i.e. the center). 
 
The Play Scheduled function is disabled in this version of Hold On.  
 
The Start/Stop menu item starts the music-with-messaging playback. Once 
started, the program will play continuously --until the Start/Stop menu item (or 
corresponding button) is revisited. 
 
The Autoplay menu item, when enabled, allows the program to start 
automatically –as soon as the program is launched. This is useful if the computer 
is rebooted. 
 
The Use CD-Audio/External MUSIC menu item allows you to use an external 
sound source for music (e.g., line-in, CD-Audio, etc.). Use this feature in 
conjunction with the Input Source select dropdown list (see below). 
 

 
 
The Use Internal/MP3 MUSIC menu item allows you to 
use the internal sound source for music (e.g., MIDI, MP3, 
WMA, etc.). Use this feature in conjunction with the music 
category/custom playlist and the USE MEDIAPLAYER 
MUSIC checkbox. 
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HELP MENU 

 
 
The Help Menu consists of two items: 
 
The Index command launches the on-line help system from within the program. 
The Help Index screen contains a table of contents from which you can get 
information on specific help topics while using the program. 
 
The About/Register menu item launches the program’s About Box, where you 
will find contact information for CD-Mediaworks, as well as any additional 
program information such as version number, etc. A special link in the About 
Box title will launch your computer’s default web-browser and take you directly 
to the registration section of the CD-Mediaworks website. 
 
THE RIGHT-CLICK POPUP MENU 

 
 
The Right-Click popup menu can be accessed by right-mouse clicking anywhere 
on the program’s main screen. This handy menu gives you quick access to some 
of the most common functions, without having to find them in the various 
menus or on-screen buttons. 
 
The following functions are offered by the right-click popup menu: 
 
Hide Hold On hides the program’s main screen while the program continues to 
work in the background. The program can then be accessed (e.g., right-clicked) 
from a small ICON on the Windows Task Bar. 
 
Show Hold On restores the program’s main screen to its default size. 
 
Use CD-Audio/External MUSIC selects your computer’s CD-ROM drive as 
the music input source. (Requires Audio CD in CD-ROM drive.) 
 
The Use Internal MIDI/MP3 selection instructs the program to use digital 
audio songs residing on your computer’s hardrive, Network Drive, etc. The song 
filenames are stored and played back based on the settings found in the various 
music category lists (e.g., jazz.msl, pop.msl, etc.) 
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DIALOGS LAUNCHED FROM THE MAIN SCREEN 
 
There are several functions offered in dialogs which can be launched from the 
program’s main screen. They are (from top to bottom): 
 
GET MSG DIALOG 
 

 
 
This is the dialog used to select various messages to play back with Hold-ON. 
Press the GET MSG button to access this dialog. 
 
GET MUSIC DIALOG 
 

 
 
This is the dialog used to select various music files to play back with Hold-ON. 
Press the GET MUSIC button to access this dialog. 
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Troubleshooting 
 
The following topics cover some of the most common technical problems that 
can occur when running this (or any) program and some helpful solutions. 
Lockups/Crashes/Incompatibilities, etc. 
 
Most problems will occur when Windows is under "stress" of some kind. This 
means that Windows spends most of its time on memory management or hard 
disk file operations. 
 
If you are having reoccurring problems, ensure that : 
 
Available RAM is at least 16,000K. This program requires a machine with at 
least 16MB of available memory to run. Check the amount of memory that's 
available before running the program by looking at the Control Panel | System | 
Performance Box (Windows 95/98). If you have an 16MB machine, there 
should be at least 8,000 K free before you run the program.  
To Free Up Memory  
 
1.) Disable any screen savers, wallpaper, or other programs before running the 
program. 
 
2.) Reduce the number of Colors displayed by your Windows System (i.e. 256 
colors instead of 16-bit or 24-bit color.) 
 
3.) Try disabling any 3rd party memory management utilities and programs (i.e. 
QEMM, RAMDOUBLER, XEROX COLOR MATCH, etc.) 
 
Hardrive Care And Maintenance 
 
SCANDISK is a small utility program that tests your hardrive(s) for errors, and 
'locks out' any problem areas it encounters so that programs do not try to write to 
them.  
Windows 95/98 users can run the SCANDISK program from the START | 
PROGRAMS | ACCESSORIES | SYSTEM TOOLS menu. Follow the on-
screen instructions provided. 
 
DEFRAG is a small utility program that tests your hardrive(s) for data 
fragmentation (i.e. non-contiguous blocks of data), and rearranges the data on 
your hardrive so that programs (and program data) are stored in an efficient 
manner.  
Windows 95/98 users should run the DEFRAG program from the START | 
PROGRAMS | ACCESSORIES | SYSTEM TOOLS menu.  
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WAVE Sound Audio is Choppy 
 
If you are experiencing choppy playback, check the following: 

1. If you are playing music files directly from the CD-ROM and are 
experiencing choppy playback, your CD-ROM may not be fast enough 
to read the digital audio data and deliver it to the HOLD ON program. 
Try increasing the Windows CD-ROM supplemental cache settings in 
the Settings | Control Panel | System | Performance | CD-ROM 
panel. 

2. Close all other open applications and accessories. Minimize the use of 
other program features while song playback is being performed. 

3. Some older models of hard drives perform an unforgiving thermal 
recalibration every 20 or 30 seconds, which can cause a glitch when 
playing audio. Generally this isn't a problem with newer drives. 

 
 
Audio is Distorted 
If you are experiencing distorted playback, check the following: 
 
1.) Volume levels may be set too high. Check the volume levels found in the 
soundcard's WIN-MIXER, and your Speaker/Amplifier/Phone System setup. Set 
all levels to a LOW or MEDIUM setting. 
 
2.) Your computer's sound card must support 16-bit audio, or it will not work 
with the program optimally for audio playback. Some 8-bit cards will simulate 
playback of 16-bit files, so you may get the card to work with the program, but 
this isn't recommended since the sound quality will still be 8-bit, and will sound 
distorted. 
 
No Sound 
1.) Ensure that all audio connections between your computer and phone setup 
are installed correctly, and that all mixer and sound volume knobs are turned up. 
 
2.) If the program claims that a wave device isn't present, and your sound card 
and driver are installed (see next section), then there may be an IRQ or DMA 
channel conflict that needs to be resolved. You may have to change the IRQ or 
DMA channel settings on your card/driver. 
Sometimes an IRQ or DMA channel conflict can cause a message that says, 'Can 
not open device. Device is currently in use', or a similar message, to appear in 
the program, even if no other program is using the wave device. Resolving the 
conflict will make the error message go away. 
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Can't Open Wave Driver Errors 
If you attempt to play a wave file (i.e. Audio Song), but the program can't open 
the wave driver, and the driver is installed, this is usually due to another 
program already using the wave device. If you aren't running any other 
programs that use the wave device, then this may be due to an IRQ, DMA, or 
Port conflict with another device. You may have to change one of these settings 
on your sound card in order to resolve the conflict. 
 
No MIDI Sound 
The program will display the list of drivers that are installed into the Windows | 
Control Panel.. If you don't see your driver displayed, it may mean: 
The driver has NOT been installed into your Windows System. Run the Settings 
|Control Panel | Multimedia Drivers program. There you should see a list of the 
drivers installed. If your driver is not on that list, then you may need to install it 
using the disks that came with your soundcard. 
 
Requirements 
This program is designed for use with Windows 98 or higher. It is also 
necessary to have Microsoft Media Player Version 6.4 installed and configured 
on your soundcard equipped PC. 
 
MP3 as music source 
If using this program with MP3 music you should use MP3s with the same 
Bitrates (i.e. 128kps or lower). You also should use at  least a Pentium II-300 
with 64MB of ram when using MP3s - especially if running the program in the 
background while using other programs. 
 
 TIP: A good alternative to MP3 music is to use the WMA format for better 
sound, better compression rates, and more troublefree operation. To create 
WMA files use our WAV-2-WMA converter program – available FREE from 
our website. 

 
 
 
 
 

CD-Mediaworks 
www.cdmediaworks.com 
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